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FX150/150+ OTDR/OLS/OPM/OLTS Package Firmware/Software Updates 

Upgrade procedures are provided at the end of this document. 

Software version: 02.02.0001 July 9, 2025 

Release Scope:  
Formal Release. General Availability 
Boot Rom version: 4.1.2 
CPLD version: 10 

OTDR features and improvements: 

1. General Enhancement 
a. Fixed issue when a background application leaves a residual pop-up image on display when switching between 

Apps using HOME button 

2. File operations and Reports 
a. No changes 

3. OTDR features and improvements 
a. No changes 

4. JSON/Waldo Test mode only 
a. No changes 

5. V-Scout® and LinkMap changes 
a. No changes 

OPM/OLS/VFL/PFP Splitter features and improvements: 

1. No changes 

Digital Fiber Inspection Scope improvements: 

1. No changes 

Known Issues: 

1. When PTS form has an empty cell, this results in misalignment of data and value from next row applied 
2. Unable to clear Results Folder Cloud Sync even after closing OTDR App or logging off Fiberizer Cloud 

 

Software version: 02.02.0000 June 23, 2025 

Release Scope:  
Formal Release. General Availability 
Boot Rom version: 4.1.2 
CPLD version: 10 

OTDR features and improvements: 

1. General Enhancement 
a. Enabled Advanced Management option for Sales to include SNs missing from the original list 
b. Updated Japanese translation 
c. Shows OPX-BOX entries only in Bluetooth selection menu 
d. Automatically connects to the previously successfully connected Bluetooth device 
e. Tweaked Bluetooth menu fonts 
f. Doesn’t show duplicate entries in the Bluetooth menu 
g. OTDR Viewer: Added "Setup…" button to the left panel menu for Auto Save, Cloud, Reset Con etc. 
h. Fixed the long span test issue 
i. Disabled item editing in profile loading menus 
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2. File operations and Reports 
a. Performs renaming OTDR results in the same manner as the platform file manager for R-Server upload. 
b. Prevents application crashing due to corrupted result files 
c. Fixed format issue with latency value in test report 
d. Limited on-board renaming feature to test filename only (OTDR, OPM, FIBERSCOPE); user will no longer be able 

to rename jobID, cableID, or fiberID 

3. OTDR features and improvements 
a. Improved measurement and analysis performance 
b. Adjusted Live measurement averaging 

4. JSON/Waldo Test mode only 
a. Updated PON test sheet to show enlarged, highlighted window for active test row and removed CableID column 
b. If a SPAN Begin length is defined, the 0km event type will be labeled as a “Launch” type within .json file to avoid 

P/F thresholds failing due to glass type mismatch. On-board LinkMap event type will remain either splice or 
connector depending on reflectance value. 

c. Always displays the Realtime (RT) button on the right menu; the RT button setting is removed 
d. If both 1310/1550nm wavelengths are not enabled when starting test, warning message will prompt users if they 

want to continue with single wavelength testing. 
e. Fixed F2_PON Setup profile initialization issue 
f. PFP Power: Automatically reloads document according to the platform UI selection 
g. PFP Power: Fixed current panel cell selection when a new document loaded 
h. PFP Power: Start->New drops current document in WALDO mode 

5. V-Scout® and LinkMap changes 
a. Preserves the SPAN Begin event loss setting when rebuilding a LinkMap 
b. Matches test report icon for splitter with LinkMap iconic image 

OPM/OLS/VFL/PFP Splitter features and improvements: 

1. Added an About button to the OPM Table tab; maintenance server access is not available in the About tab 

Digital Fiber Inspection Scope improvements: 

1. Changed text from NaN to N/A in the Analysis table 

2. Fixed issue that occurs with viewing Analysis table operating in Japanese language 

 

Software version: 02.01.0003 April 25, 2025 

Release Scope:  
Formal Release. General Availability 
Boot Rom version: 4.1.2 
CPLD version: 10 

OTDR features and improvements: 

1. General Enhancement 
a) Enable Advanced Management option for Sales supplied SN 

2. File operations 
a) No changes 

3. OTDR features and improvements 
a) No changes 

4. JSON/Waldo mode 
a) No changes 

5. V-Scout® and LinkMap changes 
a) No changes 
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OPM/OLS/VFL/PFP Splitter features and improvements: 

1. No changes 

Digital Fiber Inspection Scope improvements: 

1. No changes 

 

Software version: 02.01.0002 March 11, 2025 

Release Scope:  
Formal Release. General Availability 
Boot Rom version: 4.1.2 
CPLD version: 10 

OTDR features and improvements: 

1. General Enhancement 
a) Improved Wi-Fi / BT connection. 
b) Updated French translation. 
c) Fixed issue preventing screenshot capture. 

2. File operations 
a) No changes 

3. OTDR features and improvements 
a) Changed default threshold value for reflectance from -65 to -55 to avoid false reporting of reflective event type. 
b) Fixed issue when loading saved result, the analysis thresholds do not always load correctly. 
c) Improved general OTDR trace filtering and analysis performance especially on traces with high polarization noise. 
d) Limited editing to bult-in, custom Fiber Model setting profile. 
e) Added new Auto Zoom Trace setting control (On/Off) in View Setup Menu - Zoom center for Trace plot (centered 

or Active marker). 
f) Added new Event selection trace view response (Focus/Jump to event or Focus/Jump and zoom to event). 
g) Added support for new in-service 1650F OTDR with macro bend detection capability. 
h) Stopped adding same wavelength multiple times to the file name. 
i) Fixed issues with autosaving of the wrong document. 

4. JSON/Waldo mode 
a) PTS: Added new PON Test Sheet (PTS) feature to Fiber Menu for both OTDR and PFP Power Application. 
b) OTDR: Fiber ID is now visible on active test screen and LinkMap now WALDO fiber id on trace plot during 

measurement. 
c) OTDR: Added new factory setup profile option - F2_PON setup profile added and Push as default for WALDO 

mode. 
d) PFP Power: Table/strands are now defaulted to 992 strands (max) with selection at 0. Selecting a PTS OPM 

terminal will open PFP Power and position to correct stand to measure; alternatively, user can manually 
select/overwrite results. 

e) PFP Power: Resolved issue whenever the CableID field is empty, the PFP Power saved results go to the wrong 
path. 

f) PFP Power: Replaced “Clear” button with “Clear Cell” and now only selected cell is deleted. 
g) PFP Power: After measurement “Start”, automatically go to selected start cell to measure. 

5. V-Scout® and LinkMap changes 
a) Changed the text color in LinkMap comment ballon from grey to black. 

OPM/OLS/VFL/PFP Splitter features and improvements: 

1. Fixed ORL B->A value issue in the OPM test report. 
  



 

 

FX150/150+ OTDR/OLS/OPM/OLTS 
Software Release Notes

 2827 Lakeview Court, Fremont, CA  94538, USA    Tel: 1.510.651.0500    Fax: 1.510.651.0505    www.veexinc.com 4 

Digital Fiber Inspection Scope improvements: 

1. Improved user interface. 

2. Added new results table in user interface and test report. 

 

Software version: 02.00.0001 August 21, 2024 

Release Scope:  
Formal Release. General Availability 
Boot Rom version: 4.1.0 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) Upgraded the User Interface to the latest v150 product design concept with large, square buttons. 
b) Added the FLOWTM and QR code/NoApp® features. 
c) Added 499-05-876 Bootup PIN Code System Lock software option. 
d) Added ability to use PC keyboard entry when using web-browser. 
e) Fixed issue with Customized Profile – CNT not displaying properly. 
f) Updated Spanish and Chinese (Zh-CN) translations. 

2. File operation and related enhancements 
a) Added ability in OTDR mode to manually enter TechName and TechID unless sync’d with R-Server. 

3. .json mode 
a) No changes 

4. OTDR measurement, Profile and Analysis Improvements 
a) Factory profiles are no longer visible in the File Manager, only User Profiles are visible; any factory profiles 

uploaded from previous release must be manually deleted using File Manager and shown in green font. 
b) When OTDR App is closed, the current settings will be saved into the Last Configuration profile; the next time the 

OTDR App is opened, it will load the Last Configuration settings. 
c) Fixed OTDR App loading issue when the Application option tapped within 15-20 seconds of power up. 
d) Centers/zooms on event selected in the Event table. 
e) Tweaked Fiber Model labels and defaults. 
f) Factory reset will restore OTDR to factory built-in profile settings. 
g) Changed active trace selection icon from grey to green circular arrow. 
h) When Load BA traces only, event #s will now begin table with #1 instead of reverse sequence. 

V-Scout changes and LinkMap improvements: 
1. Fixed issue with no LinkMap being generated for some traces, even when .sor file is re-analyzed with new A.Thres 

values. 
2. Improved LinkMap merged event P/F reporting; Total merged loss value is now divided by the # of merged events 

before applying P/F indicator. 

OPM/OLS/VFL/PFP Splitter features and improvements: 
1. For OPM: 

a) Created separate dB and dBm buttons on the right side of the screen, 
b) Added ‘Select All/Deselect All’ checkbox on the Table tab, 
c) Changed the ‘Ref’ button to ‘Set Ref’, 
d) Modified Panel OPM zero instruction, 
e) Fixed issue with Modulation setting display not locked to real value. 

2. For OLS: Added ability to select laser wavelengths to use in the Loop mode. 
3. For PFP:  

a) Added the WL button on the left side of the screen, 
b) Added Strand # so users can adjust for cabinet fiber capacity, 
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c) Added Test# on the left side in case users need to skip ports, 
d) Added ‘Load’ button on the left side to allow users to repair fiber and resave test result, 
e) Added a way to Resume current test or start a New one, 
f) Changed sequence of instructions: 

- Close OPM dust cap, press ‘Zero’ (if provided meter has not been previously zeroed), 
- Clean and connect fiber between OPM and Splitter, 
- Press ‘Start’->’New’, 
- Press ‘Acquire’ to save each port reading, 
- When done testing, press ‘Stop’ and ‘Save’. 

Digital Fiber Inspection Scope improvements: 
1. Fixed bug with label on the right side not matching analysis parameters setting. 

Known Issue 
1. Within initial 15 seconds of powering up, the unit will briefly display both the Fiber Menu and Utility Menu but not 

operable until final Fiber Menu or PIN request pages are displayed. 
2. PFP Splitter and OPM QR codes are not supported yet by NoApp. 
3. Using single PW to measure multi-spaced near-end events (25 feet apart) on a 62kft span can result in missed events 

and higher event loss. 
 

Software version: 01.07.0007 April 17, 2024 

Release Scope:  
Formal Release. General Availability 
Boot Rom version: 1.4.0 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) Added ability to lock settings to prevent accidental changes. 
b) Updated Spanish Translation. 
c) Added BT pairing for VX-Connect App; customer can push json mode and GPS coordinates to saved files. 
d) Added ability to support delta releases going forward. 

2. File operation and related enhancements 
a) Added ability to export/import PROFILE to/from USB stick. 
b) Report Tab: Added option to save current view images, A/B marker position and 2-Point Loss value for multi-

wavelengths and multi-pulses traces. 
c) Added event indices to trace plot on test report. 
d) Added small margins to zoomed trace view within the test report. 
e) Fixed indexing issue when downloading results from Cloud. 

3. .json mode 
a) Fixed issue with OTDR App crashing when user added SPAN offset. 
b) Fixed issue with OTDR App crashing when attempting to save 500 feet cable with high-end reflection. 
c) Changed JobId/CFAS label to JobID/CFAS/CLO on web browser and .json file. 
d) Added Strand # to the OTDR Trace screen and LinkMap view. 
e) Set F2 P/F threshold as default when PUSH with browser; user can still change P/F setting. 
f) Prioritized WALDO AutoSaveParameters JobID over VX-Connect JobID. 
g) Fixed PFP Splitter panel dimensions. 

4. OTDR measurement and Analysis Improvements 
a) New feature - added ability for users to create/edit custom PROFILE with unique name. 
b) Removed restrictions on P/F threshold limits for Splitters. 
c) Increased the distance range from 160km to 320km for OTDR with SN prefix TAC or TNU. 



 

 

FX150/150+ OTDR/OLS/OPM/OLTS 
Software Release Notes

 2827 Lakeview Court, Fremont, CA  94538, USA    Tel: 1.510.651.0500    Fax: 1.510.651.0505    www.veexinc.com 6 

d) Changed the Trace tab measurement length details to show the value of the last captured data point instead of 
acquisition range length. 

e) Event Tab: Fixed wrong Loss value in expanded Trace screen view. 
f) Organized Fiber Models by glass type to provide improved visibility to user of all options and require less scrolling. 
g) Fixed the issue when ‘Traffic detected’ warning did not allow the OTDR measurement to be performed even if the 

traffic signal level falls below the threshold limit. 
h) Show actual measurement resolution value in settings instead of Low, Medium, High. 
i) Added new network selections for drop fiber testing: ‘Splitter to ONT’ and ‘ONT to Splitter’. 
j) Added a new ONT reflectance P/F threshold setting for ‘Splitter to ONT’ mode; LinkMap will show End icon with 

‘No ONT detected’ message or an ONT icon if the end event reflectance value meets the threshold. 
k) Made the SPAN Begin measurement more stable. 
l) Adjusted the minimum input power level according to the optical configuration. 
m) Fixed the App crash issue on units with SN prefix “TAC” and “TNU”. 
n) Improved the OPM measurement handling; removed the OPM measurement checkbox Setup on OTDRs without 

inline dual PONT option. 
o) General measurement, filter and analysis improvements. 

V-Scout changes and LinkMap improvements: 
1. Improved macro bend event reporting in LinkMap. 
2. Fixed V-Scout warning dialog for new V-Scout profiles. 
3. Improved PON/U trace analysis and LinkMap; added a new Claro V-Scout profile option. 
4. Apply saved thresholds settings when rebuilding LinkMap instead of current displayed measurement parameters. 
5. Added merged event splitter support. 
6. Improved detection of link end with merged events, last event will have the end icon. 

OPM/OLS/VFL features and improvements: 
1. No changes 

Digital Fiber Inspection Scope improvements: 
1. The OTDR App will delay showing fiberscope connected message until the application is fully loaded; notification will 

only occur once per connection. 
2. Moved settings from Capture tab to Setup tab - MPO mode, Auto Freeze, and Rects/Dots. 
3. Removed Shake setting as it’s no longer necessary due to improved analysis. 
4. Updated, reorganized and improved labels in the Settings tab to consolidate related parameters; added the Reset 

button: 
a) Added IEC 61300-3-35 edition 3.0 selection as a separate default setting rather than being included in Analysis 

Settings, reducing the number of required combinations; Fixed IEC V1/V2 details on the Capture screen, 
b) Added Connector Type (Male, Female, MPO Female) and Connector Material settings, 
c) Renamed Tip Type options for clarity and accuracy and filtered by selected Analysis Parameters and Connector 

Type settings, 
d) Improved switching between connector polish types: PC, APC and MPO modes, 
e) Fixed potential application crash, 
f) Fixed the Auto Crop Focus feature, 
g) Created a new scope report to support reduced IECv3 inspection parameters, 
h) Now always show FOV setting, 
i) Added Save button to access Save/Auto Save menu. 

Known Issue 
1. For P2P spans > 150km, user must manually set test parameters. 
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Software version: 01.05.0008 February 20, 2024 

Release Scope:  
Formal Release. General Availability 
Boot Rom version: 1.4.0 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) Restored support of the external MPO switch; users must connect switch prior to opening the Fiber Menu to 

allow OTDR time to detect the connected switch. 
b) Improved PDF test report table layout. 
c) Improved Company information table details. 
d) Improved Platform/module serial number/SW version details visibility using Fiberizer SW and within test report. 
e) Updated Spanish translations. 
f) Improved the initialization process for detecting the OTDR HW. 

2. File operation and related enhancements 
a) Added ‘Save Current Measure Trace View’ checkbox to Save (currently only supports 1PW testing) and includes 

loss measurement and A/B marker positions within test results and report. 
b) Fixed Redundant version number in .pdf and .html test report. 
c) Added Measurement parameter setup table to Trace Info details and test report. 
d) Saves Test mode and Network mode setup details are used to capture test results in .sor file for later viewing. 
e) Improved text in Trace info viewing window. 

f) OTDR .json mode 
i) Fixed issue with strand # lost when test application is closed; now remember the last tested strand. 
ii) When using web browser with .json OTDR mode pushed to OTDR, the distance unit will initially be set to feet 

and ‘Clean-up Trace List before Measurement’ automatically be enabled; removed Clean-up from Display 
setup. 

iii) Added Strand # button to allow user to change strand # locally prior to new test. 
iv) Added Autosave Overwriting warning when in .json mode; if filename already exists, asks user if they wish to 

overwrite previously saved result with same filename. 
v) Remember the last used autosave index value between application launches in .json mode. 
vi) Changed Network label from 'P2P' to 'P2P/PON Drop fiber' when in WALDO mode. 

3. OTDR measurement and Analysis Improvements 
a) Fixed 1550nm index value for SMF-28e+ glass to 1.4679. 
b) Added missing 'Cancel' buttons to some pop-up setup windows. 
c) Fixed issue with connector labels in Setup displayed in wrong position (OTDR<->AUX) on some OTDRs/HW. 
d) Deleted P/F threshold ‘CBand BFS’. 
e) Renamed P/F threshold 'CBand CONST' to 'CBand'. 
f) Fixed pulse width display for values over 20 usec. 
g) Improved Analysis, filter, and measurements including calculation of partially measurable events. 

V-Scout changes and LinkMap improvements: 
1. Improved event loss calculation and synchronization with LinkMap values. 

OPM/OLS/VFL features and improvements: 
1. Changed PFP default P/F threshold to -21 dBm. 
2. Added support for ‘special’ PN Z66-00-061G OPM option +15 to -65dBm. 

Digital Fiber Inspection Scope improvements: 
1. Fixed potential application crash. 
2. Always analyze fiberscope images to avoid results with no analysis. 
3. Fixed missing image analysis indication. 
4. Improved Job information table (Fiberscope report). 
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Software version: 01.04.0006 September 26, 2023 

Release Scope:  
Formal Release. General Availability 
Boot Rom version: 1.3.1 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 

a) Updated Spanish, zh_Chinese translations. 
b) Updated UI style guide to match new requirements for fonts and colors. 
c) Fixed the issue with Connection Quality Check Save/Load. 
d) Restored the Fiber model to SMF28e; customized SM and MM fiber models are now available. 
e) JSON OTDR and JSON PFP OPM features: 

i. Released new PFP Splitter test mode (POPM) to measure 1550nm levels at distribution cabinets and save 
all strands in single .html and .json PFP file. Users can select first and last strands for cabinet up to 864 
strands and move back and forth between strands with same JobID and CableID. 

ii. Users can select first strand # to be tested for cabinet JobID/CableID displaying 128 cells per OLT. 
iii. Changed json mode labels in JobID/AccountID from PFP to OPM on the web browser. 
iv. Changed P/F OPM default to -21dBm. 
v. Technician can resume testing using Start/ Stop to finish previous test using the original file saved in the 

test set; Fit “Save Continuously” label. 
vi. When technician uses the AccountID/JobID OTDR feature in the web-browser to push details to OTDR, the 

unit will save results automatically using pushed details; label changed from OK to Save; fixed potential 
crash when saving result; added new “Waldo…” right menu button in LinkMap view. 

vii. Updated .json OTDR file format content; changed ‘port’ label to ‘strand’; displays Length and P/F Status in 
the SaveResultDialog window. 

viii. Added new “Tag” feature to .json OTDR test mode to allow users to view the list of failed (tests) strands 
previously ‘tagged’. 

ix. Restored missing right menu buttons in Trace View. 
x. Improved handling of LinkMap span merged events. 

2. File operation and related enhancement 
a) Fixed the intermittent html/pdf report crash issue. 
b) Ignores corrupt files during the Fiberizer Cloud upload process. 

3. OTDR measurement and Analysis Improvements 
a) Fixed network configuration type default load. 

V-Scout changes and LinkMap improvements 

1. Changed ‘Link Start’ and ‘Link End’ labels to ‘Fiber Begin’ and ‘Fiber End’ in LinkMap. 
2. Now displays Loss readings with two decimal places instead of one in LinkMap. 

OPM/OLS/VFL features and improvements: 

1. Fixed the issue with OLS/OPM application not loading if BB-OPM hardware option was disabled. 

Digital Fiber Inspection Scope improvements: 

1. Fixed DI-1000 crop mode issue and restored crop state. 
2. Fixed DI-3000 resolution change issue. 
3. Fixed MPO FOV visibility error. 
4. Updated the Setup tab. 
5. Changed “Tip type” labels to be more intuitive. 
6. Fixed Live/Pause label on the Capture view. 



 

 

FX150/150+ OTDR/OLS/OPM/OLTS 
Software Release Notes

 2827 Lakeview Court, Fremont, CA  94538, USA    Tel: 1.510.651.0500    Fax: 1.510.651.0505    www.veexinc.com 9 

7. Now shows Status under Analysis table. 

Known Issues: 

1) When the 1310nm Auto Test selects a 120km distance range and high resolution it will use the wrong pulse width and 
display will show the wrong text. 

 

Software version: 01.02.0027 August 30, 2023 

Release Scope:  
Formal Release. Limited Availability 
Boot Rom version: 1.3.1 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) No changes 

2. File operation and related enhancement 
a) No changes 

3. OTDR measurement and Analysis Improvements 
a) Changed Res High value from 0.5m to 2.0m when distance range setting = 120km. 

V-Scout changes and LinkMap improvements 

1. No changes 

OPM/OLS/VFL features and improvements: 
1. Fixed issue where OLS/OPM application won’t load if no BB-OPM hardware option is enabled. 

Digital Fiber Inspection Scope improvements: 

1. No changes 

Known Issue: 

1. When Distance Range is set to 120km and Resolution to High, the OTDR will display an error message.  This software 
will provide a work-around to the issue by changing the resolution from 0.5 to 2.0 meters.  The next General 
Availability release software will provide the actual SW fix. 

 

Software version: 01.02.0025 August 3, 2023 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.3.1 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) Updated the Spanish translation file. 
b) Changed font style used. 
c) Relocated the AutoSave setup button from the right-side menu to the main window next to the Span button. 
d) Initial release of json PFP mode in web browser; full feature release will come with next SW release. 

2. File operation and related enhancement 
a) Now ignores corrupt files while pushing files to the Cloud to avoid unit hanging up. 
b) Added the Event threshold profile name to the OTDR test report. 

3. OTDR measurement and Analysis Improvements 
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a) General measurement improvements. 
b) Improved connection quality checking. 
c) Fixed Reflection measurement value bug. 
d) Updated Fiber Model setup list. 
e) Improved Length selection availability and selection; users now have access to all units, but default depends on 

the region. 
f) Now merged events tagged with “*” can be viewed on event table; no need to double tap merged icon to view 

full details of merged events. 
g) Improved P2P Auto Test parameters for spans >90km; for spans >110km user may need to do Manual setup. 

V-Scout changes and LinkMap improvements 

1. V-Scout profile improvements: fixed label for PON and allow profile editing, cloning, renaming and deleting user 
profile. 

2. PON demo file adjusted to display correct LinkMap upon initialization. 
3. Improved LinkMap UI diagram. 
4. Now shows V-Scout profile and measurement mode in Trace Information dialog window. 

OPM/OLS/VFL features and improvements: 
1. No changes 

Digital Fiber Inspection Scope improvements: 

1. Added brightness and contrast control to Live Capture View. 
2. Added Field of View Pg 2 setup: Auto, Standard (DI-1000/DI-1000MPO), Wide (DI-1000L/DI-1000MPO+). 
3. Improved handling of “Save” button. 
4. Added Unique test result filename upon saving. 
5. Updated German, Spanish, simplified Chinese translations. 
6. Now Fiberscope application saves parameters before closing. 
7. Removed Local/Remote Mode selection; the correct mode will be auto selected. 
 

Software version: 01.01.0034 February 24, 2023 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.3.1 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) No changes 

2. File operation and related enhancement 
a) No changes 

3. OTDR measurement and Analysis Improvements 
a) Added P/F threshold profiles to meet ISO/IEC 11801, ISO/IEC 14763-3, IEC 61280-4, G.6697/G.98x standards. 
b) Added P/F Event thresholds name above the P/F table in the OTDR test report. 
c) Added G.654 Corning TXF 2022 to fiber model setup list. 
d) Changed V-Scout Auto PON Drop to V-Scout PON ONT – Splitter and reduced distance range from 10km to 6km. 
e) Improved SPAN launch cable setup for dual λ testing. 
f) Improved OTDR Viewer BT Device connection cancelling issues. 
g) JSON – Increased download file limit to >2000 records. 
h) JSON – For dual λ tests, if any event not on both test results, use NULL instead of NA. 
i) JSON – Change text “LinkStart” to “Connector”. 
j) Fixed APP crash issue that occurred on some OTDRs after upgrading software. 
k) Improved trace analysis and filtering esp. for 100m fiber 
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l) Fixed issue with Sample PON demo trace displaying wrong LinkMap 
m) All length units (m, km, feet, kfeet, miles) will display regardless of Global settings (metric or imperial) 

V-Scout changes and LinkMap improvements 

1. No changes 

OPM/OLS/VFL features and improvements: 

1. No changes 

Digital fiber inspection scope improvements: 

1. No changes 

 

Software version: 01.01.0029 January 4, 2023 

Release Scope:  
Formal Release. General availability and mandatory critical upgrade for OTDRs with SN prefixes TAC and TNU  
Boot Rom version: 1.3.1 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) No changes 

2. File operation and related enhancement 
a) No changes 

3. OTDR measurement and Analysis Improvements 
a) Fixed issue that caused intermittent, erroneous Automode measurement results when testing short fibers for 

OTDRs with serial number prefix TAC and TNU. 
b) Fixed issue with late reporting fiber end. 

V-Scout changes and LinkMap improvements 

1. No changes 

OPM/OLS/VFL features and improvements: 
1. No changes 

Digital fiber inspection scope improvements: 

1. No changes 

 

Software version: 01.01.0026 October 25, 2022 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.2.3 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) Added support for new OTDR SN prefix TAC and TNU; added SN for PON tuned OTDRs with SN prefix TRF. 
b) Added test report translation support for Spanish, Portuguese, Chinese (Simplified) and French; increased loss 

values to 3-decimal places. 
c) OTDR Viewer Mode: Fixed initialization bug; improved messaging when no OPX is detected; hide “Cleanup Traces 

before Measurement” and “Setup Tab” in Viewer mode; default onto Results Tab”; keep Measurement Plan 
setting and sorting. 
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d) Changed label on operations from Abort to Cancel. 
e) Implemented fan control with Rev D PCB. 
f) Added pdf file when downloading result using web browser. 
g) Added ‘SKIP’ fiber index feature to built-in web browser in JSON save mode. 

2. File operation and related enhancement 
a) Pushes the entire folder of saved results including LinkMap to Fiberizer Cloud. 
b) Adds Platform and Module details into .sor file. 
c) Improved report format and labels. 

3. OTDR measurement and Analysis Improvements 
a) Added new Advance PON support for PON optimized OTDRs only; non-PON OTDRs will not support Advance PON 

features. Improved Lmax, filter and analysis for PON spans. 
- Supports up to 3 balanced splitters. 
- Supports unbalanced splitters. 
- Supports Taps. 

b) In PON/B or PON/U Network mode, Profile Setting is default to Manual PON allow user to specify test link details. 
c) In PON/B or PON/U Network mode, EOF value is hardcoded to 20dB. 
d) Added Real Time Refresh rate update setting Low vs. High (original) to get more smooth trace signature. 
e) Increased microbend default threshold from 0.2 to 0.5dB and changed dB/km to unselected by default. 
f) Increased P/F threshold values; added 3 new factory P/F settings: F2 PON, C-Band CONST and C-Band BFS. 
g) Fixed negative number value format in test report. 
h) Added setup to show Real Time button on right side menu. 
i) Added user setting to choose which Tab to display upon completion of test. 
j) Added support for OPX-MPO-12 switch to FiberMenu. 
k) Added support for VConnect APP (internet access, RServer and auto enable GPS coordinates and save to .SOR 

using AutoSave or manual Save when paired).  View GPS coordinates in Save setup Menu under Common tab. 
- Apple devices – Download VxConnect ver. 2.1.0 Build 61 or higher from VeEX APP site (turn on BT and 

HotSpot), 
- Android devices – Download VConnect from Google Play Store. 

V-Scout changes and LinkMap improvements 

1. Fixed Auto VScout unit selection bug. 
2. Fixed APP crashing when VScout is not enabled; when VScout icon is tapped, display message on Fiber Menu stating 

option not supported. 
3. Improved event icons and merged event thresholds. 
4. Improved V-Scout profile editing; removed redundant V-Scout test profiles. 
5. Improved filters for PON and LinkMap analysis. 

OPM/OLS/VFL features and improvements: 

1. Added support for 1490/1577nm in-line PON measurement. 
2. Fixed OPM WID measurement issue and OPM crash when option not enabled. 
3. Updated FX81 2WL tethered thresholds values. 
4. Display VeEX product SN instead PCB SN. 

Digital fiber inspection scope improvements: 

1. Short/long stem switched for old results. 
2. Added DI-1000 MPO+/MPO selector option to support different FOV specifications. 
3. Fiber image size decreased for DI-1000 MPO+. 
4. Fixed P/F analysis threshold check. 
5. Retain FiberScope settings for APP reloads. 
6. Restored DI-3000 Freeze/Live button operation. 
 



 

 

FX150/150+ OTDR/OLS/OPM/OLTS 
Software Release Notes

 2827 Lakeview Court, Fremont, CA  94538, USA    Tel: 1.510.651.0500    Fax: 1.510.651.0505    www.veexinc.com 13 

Software version: 01.00.5014 June 23, 2022 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.2.2 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) JSON changes 

- Added new ReDO feature to overwrite existing fiber test results and save with new time stamp. 
- Added specific DWDM wavelength/CH# labels. 

V-Scout changes and improvements 

1. No changes 

OPM/OLS/VFL features and improvements: 

1. No changes 

Digital fiber inspection scope improvements: 

1. No changes 

 

Software version: 01.00.5008 May 27, 2022 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.2.2 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) Added new Account/JobID fields to the web browser menu for the new JSON feature.  No special characters are 

allowed in the fields. 
b) Updated Simplified Chinese translation. 

2. File operation and related enhancement 
a) Added ability to save and download results in the JSON format with new AutoSave menu modified for JSON and 

the Reset button to revert to the normal OTDR AutoSave menu 

3. Measurement and Analysis Improvements 
a) Added new F2 PON pass/fail test profile 

OPM/OLS/VFL features and improvements: 

1. No changes 

Digital fiber inspection scope improvements: 

1. Added support for DI1000L fiberscope 
2. Fixed different model scope jpeg backward compatibility issue 
3. Improved DI-1000MPO+ image analysis 
4. Fixed Fiberscope freeze/resume button 

Known Issues 

1. When special characters are entered into the Account/Job ID field, although you get confirmation data is saved, it is 
not actually pushed onto OTDR Autosave menu.  Solution - Don’t use any special characters. 

 



 

 

FX150/150+ OTDR/OLS/OPM/OLTS 
Software Release Notes

 2827 Lakeview Court, Fremont, CA  94538, USA    Tel: 1.510.651.0500    Fax: 1.510.651.0505    www.veexinc.com 14 

Software version: 01.00.4997 February 7, 2022 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.2.1 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) Changed network type from PTP to P2P 
b) Fixed maintenance server related crash (sleep/wakeup) 
c) Improved Report save time 
d) Added Exit functionality to About view. 
e) Removed redundant controls when using the OTDR Viewer and the About view 
f) Improved the OTDR Viewer initialization message 
g) Now shows filename (TraceID content) on OTDR Traces viewing display 
h) Raised OTDR traffic detection level from -40 to -30dBm 
i) Fixed OTDR overwriting error when upgrading remotely 

2. File operation and related enhancement 
a) Applied a new test report design: new font, added more user details, removed empty user defined fields 
b) Fixed TRACE file saving time stamp to adapt for time zones and daylight saving 
c) Changed autosave test # increment from Fiber ID to Trace ID 
d) Fixed OTDR Auto save parameters dialog crash issue 

3. Measurement and Analysis Improvements 
a) Added OTDR Network type combo box annotations to settings 
b) Adjusted OTDR Default event threshold values 
c) Improved OTDR Analysis: PON and event splice recalculation tweaks 
d) Redefined OTDR event thresholds’ limits to be more realistic for current applications 
e) Multi-wavelength testing, allow different PWs in auto settings to ensure end detection on very long fibers 

V-Scout changes and improvements 

1. Added Sync Event table counter with LinkMap counter 

2. LinkMap display is now available to all OTDRs.  V-Scout test profile is still optional and required purchased option for 
PON OTDRs and recommended for all other OTDRs. 

3. Fixed bug and re-instated including larger PW if required for high loss or very long fibers  

OPM/OLS/VFL features and improvements: 

1. OPM wavelength set support 
2. Adjusted OPM measurement dialog buttons 
3. If supported, shows OLS 330Hz button; if not supported, hides button after OLS application is loaded. 
4. Added FX80/81T tethering support for BB-OPM and PON mode; user should select mode using OPM 

Digital fiber inspection scope improvements: 

1. Added test profile for LC/APC short, angled female tip 
2. Added support for MPO16 
3. Added saving test parameters (company, operator, etc.) and data to test report 

OX-MPO-12 improvements: 

1. No change 
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Software version: 01.00.4976 October 29, 2021 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.2.0 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) Fixed the OTDR server crash 
b) Added support for new receiver calibration parameters 

2. File operation and related enhancement 
a) No change 

3. Measurement and Analysis Improvements 
a) Improved Filter/Analysis performance 
b) Improved zero-km measurement point 
c) Improved LinkMap splitter detection 

4. V-Scout changes and improvements 
a) No change 

OPM/OLS/VFL features and improvements: 

1. Fixed the OPM server crash 

Digital fiber inspection scope improvements: 

1. No change 

OX-MPO-12 improvements: 

1. No change 

 

Software version: 01.00.4968 June 30, 2021 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.2.0 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) Added Italian language support to test set and result report 
b) Updated Russian language 
c) Fixed Splash screen 
d) Moved About from tab to Setup menu button 
e) Fixed FiberizerCloud upload issue and error message for OTDR, OPM, FiberScope 

2. File operation and related enhancement 
a) Added oxlts optional time support 
b) Autosave labels changed 
c) Fixed report trace grid display values 
d) Updated report event table text/labels 
e) Separated cumulative/total loss labels in report 
f) Fixed report reflectance value format 

3. Measurement and Analysis Improvements 
a) Improved Filter/Analysis performance 
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b) Improved API “RefEventSCalculate” command 
c) Improved zero-km measurement point 
d) Improved Fiber Model list; updated Fiber model values for Corning SMF-28e Ultra, SMF-28e+, SMF-28-ULL glass 
e) Don’t indicate P/F thresholds on event table view; show P/F on LinkMap 
f) Fixed tab/viewing issue bug 
g) Improved low level filter/analysis measurement results 

4. V-Scout changes and improvements 
a) Improved LinkMap - automatic analysis: compare-no analysis, compare-with-analysis, added additional modify 

commands; other misc improvements 
b) Add comment in Reflective Event LinkMap icon regarding merged events 
c) In manual mode, if EOF > 30dB LinkMap analysis will now assume testing PON network 
d) PON mode: if have merged event at end that shows high loss then change end icon to splitter even if can’t 

accurately display patch cord after splitter. 

OPM/OLS/VFL features and improvements: 

1. Remove OLTS tab for OS/OPM APP 

Digital fiber inspection scope improvements: 

1. Improve Error dialog text 
2. Added FiberScope switch support for DI-3000 to remote connect to via Wi-Fi 
3. Update threshold table header 
4. Add pdf report generation 
5. Fix issue with showing wrong analysis parameters/tip on measurement results 
6. Add portrait report orientation 

OX-MPO-12 improvements: 

1) No change 

 

Software version: 01.00.4950 December 24, 2020 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.2.0 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) Added Finnish translation 
b) Improved Chinese, German and Spanish translations 
c) Moved OTDR About as a button to the Setup screen 
d) Now shows the Unlock & Time on unregistered units for R-Server status 

2. File operation and related enhancement 
a) No change 

3. Measurement and Analysis Improvements 
a) Improved color selection between tests to provide more contrast when viewing multiple traces 
b) Improved ORL formatting in manual ORL mode 

4. V-Scout changes and improvements 
a) No change 

OPM/OLS/VFL features and improvements: 

1. Resolved issue with VFL laser not turning off after closing test application 
2. Improved OLS operation; corrected laser wavelength disappearance issue 
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3. Improved OPM to OTDR APP swapping 

Digital fiber inspection scope improvements: 

1. Improved DI-3000 FiberScope operation for Wi-Fi and USB/wired (except MPO tip) 
2. Improved MPO analysis, MPO OpenCV 

OX-MPO-12 improvements: 

1. No change 

Known issues: 

1. VFL fails if no OLS or OPM option is enabled. 

 

Software version: 01.00.4939 September 23, 2020 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.2.0 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) Activated HOME button to mirror HOME icon operation when in Fiber Test Mode 
b) Added WiFi connection support to OTDR Viewer application for OPX-BOXe 
c) Added features with R-Server support including:  

i. Timebomb feature 
ii. V-Connect application 

d) Removed WiFi Insider from Advanced Menu 
e) Corrected copyright and date/time on web homepage and VNC page 
f) Corrected Upgrade messaging when language set to Chinese or Japanese 
g) Updated zh_CN (Mandarin) translation 

2. File operation and related enhancement 
a) No change  

3. Measurement and Analysis Improvements 
a) Resolved Realtime test trace compression issue when test stopped 
b) Improved Trace Report including improved ORL calculation 
c) Now users can apply analysis to results even if test stopped prematurely 
d) Corrected issue with floating numbers which impacted some analysis results 

4. V-Scout changes and improvements 
a) No change 

OPM/OLS/VFL features and improvements: 
1. Resolved issue with VFL laser not turning off after closing test application 

2. When OPM is not enabled, tapping OPM will no longer open test application 

Digital fiber inspection scope improvements: 

1. Updated FiberScope icons 
2. Added DI-3000 FiberScope support for WiFi and USB/wired (except MPO tip) 
3. Improved support for MPO analysis 

OX-MPO-12 improvements: 

1. No change 
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Software version: 01.00.4920 March 30, 2020 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.2.0 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) Resolved EZ Remote issue when set to Japanese 
b) Added Web browser reboot feature 
c) Added Display setting (antialiasing) to show trace view with thinner line 

2. File operation and related enhancement 
a) Restored demo sample trace files 
b) Improved Trace list view 

3. Measurement and Analysis Improvements 
a) Updated OTDR image and now shows full zoom according to wavelength/pulse settings when new measurement 

started 
b) Improved distance unit handling: now the pdf-report reflects the saved units and not defaults to km 
c) Improved Measurement completion process; continuous improvement to analysis routines 

4. V-Scout changes and improvements 
a. No change 

OPM/OLS/OLTS features and improvements: 

1. Fixed ‘No device available’ notification (i.e., OLS option not available, display message) 

Digital fiber inspection scope improvements: 

1. No change 

OX-MPO-12 improvements: 

1. No change 

 

Software version: 01.00.4912 February 4, 2020 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.2.0 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) New Fiber Menu layout including EZ-OTDR, V-Scout Auto, Expert OTDR, and FiberScope 
b) Bootup time to FiberMenu is <15 seconds; FiberMenu+OTDR APP < 30 seconds 
c) Updated Japanese, Chinese and Spanish translations and adjusted label widths 
d) No device available notification fixed (i.e., OLS option not available, display message) 

2. File operation and related enhancement 
a) Added R-Server Registration and Advanced Management support. 
b) Automatically replace special characters and spaces in filenames with underscore for RServer 
c) Added new OTHER save fields for originating/terminating locations, comments, NodeID, Account, TechID and 

TechName 
d) Added ability to save filtered .sor files for 3rd party view. 
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e) File save time reduced to ≤ 2 seconds for single .sor file 

3. Measurement and Analysis Improvements 
a) When available, 1550nm is the new factory default 
b) Improved LMax (Distance Range) selection 
c) Consolidated OTDR Setup into single page view; improved Fiber Model options; user can create setup profiles.  

The factory default is now Corning SMF28. 
d) Improved Measurement completion process; continuous improvement to analysis routines 
e) Optimized P/F thresholds 
f) New bi-directional trace X view and event analysis added 
g) Added Display setting button to Right-side menu; new support user defined grid spacing (fixed v. auto scale) and 

grid background color (Light v. Dark) 
h) Improved consistency between ORL measurement values (Event table, manual measurement and LinkMap) 

4. V-Scout changes and improvements 
a) Improved LinkMap parameters association 
b) Span Start/End icons no longer greyed out when Loss Excluded checked.  
c) V-Scout tab label changed to LinkMap 

OPM/OLS/OLTS features and improvements: 

1. Fixed OLS wavelength select issue 
2. Improved OPM Zero 
3. Improved VFL laser operation 

Digital fiber inspection scope improvements: 

1. Added direct connect support for DI-2000/3000 Fiberscopes 

OX-MPO-12 improvements: 

1. Added support for new OPX-MPO12 optical switch. Users must connect prior to opening OTDR APP. 

 

Software version: 01.00.4861 April 19, 2019 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.1.20 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) New bootrom ver. 1.1.20 and CPLD ver. 10 
b) Support custom logos 
c) Home button will take user to Utility menu 
d) Home icon on touchscreen will take user to Fiber Menu 
e) Improved Spanish translation 
f) Added Japanese translation 

2. File operation and related enhancement 
a) Improved USB Export 
b) Added operator field to Save Menu 

3. Measurement and Analysis Improvements 
a) OTDR traffic detection trigger set at -40dBm 

4. V-Scout changes and improvements 
a) No change 
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OPM/OLS/OLTS features and improvements: 

1. No change 

Digital fiber inspection scope improvements: 

1. Restored ability to use FiberScope APP even if no Scope detected. 

 

Software version: 01.00.4850 February 20, 2019 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.1.19 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) Improved EZRemote feature 
b) Improved language support where multi-languages exist between platform and Application software 
c) Improved platform communication with new FX150+ OTDR 

2. File operation and related enhancement 
a) No change 

3. Measurement and Analysis Improvements 
a) Added Realtime Automode and Realtime On-The Fly test modes 

4. V-Scout changes and improvements 
a) No change 

OPM/OLS/OLTS features and improvements: 

1. No change 

Digital fiber inspection scope improvements: 

1. Improved DI-1000 Crop feature Shake detection 

 

Software version: 01.00.4842 January 16, 2019 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.1.16 
CPLD version: 10 

OTDR features and improvements: 

1. General enhancements 
a) Added support for new FX150+ SN prefix 
b) The bootup time to OTDR Start now is 1 minute; improved OTDR initialization 
c) The software option list now shows V-Scout Link Mapper instead of FX300 VFL 

2. File operation and related enhancements 
a) Added the Operator field to Saved Files 
b) Improved the GPS detection 
c) Added HTML reports for the R-Server 

3. Measurement and Analysis Improvements 
a) Improved the Auto mode for FX150+ using short pulse and test time 
b) Improved the Auto mode detection for short and very long fibers 
c) Improved the EOF detection for non-reflective ends and multi-trace analysis LinkMap results 
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d) Added the Manual and Auto Real time test modes.  The Manual RT supports on-the-fly parameter changes 

4. V-Scout changes and improvements 
a) Auto freeze now works even if Image center offset by up to 33% 
b) Added the check box for re-analyzing when rebuilding LinkMap 

OPM/OLS/OLTS features and improvements: 

1. Improved OPM result saving 
2. Added the HTML report support for R-Server 

Digital fiber inspection scope improvements: 

1. Improved the auto zoom after image is frozen 
2. Added the crop option for APC images 
3. Improved the LC/APC auto-freeze and pass/fail analysis 
4. Improved the Auto freeze: centering and shake 
5. Added the HTML report support for R-Server  
 

Software version: 01.00.4827 October 24, 2018 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.1.13 
CPLD version: 9 

OTDR features and improvements: 

1. General enhancements 
a) Added EZ-Remote client access feature 
b) Improved the low battery operation. When the unit has a low battery (<10%), the warning message will now allow 

the user to exit the dialog and continue using the unit. 

2. File operation and related enhancements 
a) Now user can force TraceID # in Setup to change to a new number prior saving if sequential # increments not 

desired. 
b) Flag when user create filenames with space or / (specialty characters) as it can disrupt test operations 

3. Measurement and Analysis Improvements 
a) Improved the Manual mode test timer when using MM OTDR. 
b) Splices with Signal gain that exceed the threshold value will no longer be failed in the Event table or LinkMap 

4. V-Scout changes and improvements 
a) Redesigned OTDR V-Scout Profile setup screens  

OPM/OLS/OLTS features and improvements: 

1. File operation and related enhancements 
a) Updated OPM results will be put into OTDR results path when they are copied from the USB 

Digital fiber inspection scope improvements: 

1. Improved Auto Freeze and Pass/Fail Analysis for LC/APC and E2000/APC.  User can now specify the connector type:   
General, LC/APC or E2000 

2. Added MPO Group Viewing/Capture Mode.  No Pass/Fail Analysis. 

Known Issues: 

1. For span > 80-90 km, 1310nm places EOF label by extrapolating slope to noise floor 
2. FiberScope image files or oxlts files are not available for viewing and copying in Utilities>File>Saved.  Must use the 

FiberScope or OPM Application Export USB feature to copy file to USB or push files to the Cloud. 
3. Auto-Mode is not selecting correct PW at 1310nm for long fibers (>90km).  Use Manual or V-Scout Profile 
4. Home button does not do anything in OTDR mode 
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Software version: 01.00.4759 July 3, 2018 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.1.11 
CPLD version: 8 

OTDR features and improvements: 

1. General enhancements 
a) Added 10 second delay between the platform software loading and opening OTDR application after powering up 

2. File operation and related enhancements 
a) No changes 

3. Measurement and Analysis Improvements 
a) Event with gain (negative loss) will no longer be catagorized as a failed event 

4. V-Scout changes and improvements 
a) No changes 

OPM/OLS/OLTS features and improvements: 

1. No changes 

Digital fiber inspection scope improvements: 

1. No changes 

Known Issues: 

1. Real-time mode defaults to Manual mode test settings even when Auto or VScout selected 
2. For span > 80-90 km, 1310nm places EOF label by extrapolating slope to noise floor 
3. When the splice gainer value exceeds the splice loss P/F threshold, it shows as a failure in the Event Table 
4. FiberScope image files or oxlts files are not available for viewing and copying in Utilities>File>Saved.  Must use the 

FiberScope Export USB instead in the application 
5. For 1310nm long fibers (>90km) Auto-Mode is not selecting correct PW.  Use Manual or VScout Profile 
6. When No trace end is visible above the noise floor, EOF will often be found late.  To maximize test range, need to 

optimize DR, increase PW & Test Time and use the low resolution. 
 

Software version: 01.00.0067 June 15, 2018 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.1.11 
CPLD version: 8 

OTDR features and improvements: 

1. General enhancements 
a) Improved the Cloud Setup dialog appearance  
b) Updated the user manual 
c) Added the EZ-Remote feature support 
d) Updated the internal user manual 

2. File operation and related enhancements 
a) No changes 

3. Measurement and Analysis Improvements 
a) Improved the OTDR Span Begin/End setup 



 

 

FX150/150+ OTDR/OLS/OPM/OLTS 
Software Release Notes

 2827 Lakeview Court, Fremont, CA  94538, USA    Tel: 1.510.651.0500    Fax: 1.510.651.0505    www.veexinc.com 23 

b) Improved the 2nd splitter PON event recovery, minimized dropout 
c) Improved the splice detection on PON networks 
d) Corrected the Leaf fiber IOR setup association G.652 to G.655 
e) Added distance information to the vertical marker/cursor. Added cumulative loss at the marker position in the 

Event View 
f) Corrected reported issue that unit can freeze up when attempting to zoom in 
g) Now Span Begin/End settings automatically applied to all traces displayed in the viewing window 
h) Improved the End of fiber event loss and the reflection handling by not including results into total span values 
i) Added the scattering limit for reference events 
j) Increased the event threshold from 20 to 30 
k) Updated splitter threshold values and added support for 1x64, 1x128, 2x64 and 2x128 splitters 
l) Improved analysis results when using the 190nsec Pulse 

4. V-Scout changes and improvements 
a) Improved Total Span ORL with LinkMap Total ORL results 
b) Improved reporting of merged events from multiple spans in LinkMap  
c) Improved LinkMap for the AutoPON test; updated splitter loss threshold values and added 1x64, 1x128, 2x64, 

2x128 splitter support 
d) LinkMap layout changed to incorporate icon messaging.  Users must now select tab to display results for the 

current icon or the total span 
e) Improved VScout analysis for 190nsec 

OPM/OLS/OLTS features and improvements: 
1. Added the Pass/Fail threshold indication in oxlts files 
2. Added support for RXT4111 Light source, option 499-05-806 

Digital fiber inspection scope improvements: 
1. Added support for VS500 short/long stem and auto-detect for the installed stem 
2. Improved auto-freeze and Pass/Fail analysis when using VS500 APC tips 

Known Issues: 
1. Real-time mode defaults to Manual mode test settings even when Auto or VScout selected 
2. For span > 80-90 km, 1310nm places EOF label by extrapolating slope to noise floor 
3. When splice gainer value exceeds splice loss P/F threshold, event table shows it as a failure 
4. Can’t view FiberScope image files in Utilities>File>Saved.  Must view and copy files using Scope APP Export USB 
5. For 1310nm long fibers (>90km) Auto mode is not selecting correct PW.  Use Manual or VScout Profile. 
6. When No trace end is visible above the noise floor, EOF will often be found late.  Optimize for DR, increase PW & test 

time and use low resolution to maximize test range.  
 

Software version: 01.00.0064 March 7, 2018 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.1.10 
CPLD version: 8 

OTDR features and improvements 

1. General enhancements 
a) Improved Italian and Russian language support  
b) New rootfs to stabilize Test application and disable Auto Reset 
c) Aligned time zone settings 
d) Improved WiFi connection; added 5G Wi-Fi/Bluetooth support 
e) Changed VNC cursor prompt to ‘x’ 
f) Improved USB exporter 
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g) Corrected intermittent Application reset 
h) Added boot up Quick Guide image screens (Side button and Zoom introduction) 
i) Added new language support:  Chinese, Spanish, Portuguese and Polish 
j) Home icon will load Fiber Test menu; Home button will load Utilities menu. 
k) Now supports FX150 remote control and pdf file transfer via ReVeal FX300 ver. 1.0.5 
l) Now supports the wireline Ethernet via OTG cable 

2. File operation and related enhancements 
a) Improved Bluetooth file transfer process  
b) Added possibility to create pdf report by selecting saved .sor result files and applying ‘pdf to USB‘ feature in 

Utilities>Files>Saved>pdf  

3. Measurement and Analysis Improvements 
a) Improved section length calculation when merged events involved 
b) Improved auto analysis event detection (low splice, longer fiber, no end reflection) 
c) Improved auto distance range detection for long fibers 
d) Increased 1310nm auto PW when testing long fibers 
e) Now can supports event detection or user entered length for SPAN Start/End.  User can choose to include/exclude 

connector insertion loss 
f) Improved Event Pass/Fail check for merged events.  Merged Event will show highest Reflectance value 
g) Added new IOR for AT&T fibers 
h) The new Factory default settings 

- for Auto test mode: Not A PON with disabled Front Panel check 
- for multi-wavelength (1310/1550) options: 1550 wavelength testing 
- for P/F Analysis:  splice=0.3dB, connector=0.75dB; Refl= -40dB; ORL = 28 dB 
- for event table:  splice=0.1dB 

4. V-Scout changes and improvements 
a) Improved section loss calculation and display section length in LinkMap 
b) Now the end of fiber length measurement is displayed BOLD in LinkMap 
c) Applied grey color to out-of-span events in event reports 
d) Improved LinkMap Set SPAN setup.  Still limited to Event, not Length entry. 
e) When using VProfile it’s required to select and save PW(s) before testing is allowed 

OPM/OLS/OLTS features and improvements 

1) Added Pass/Fail threshold indication in oxlts files 
2) Able to view oxlts files using Utilities>Files>Saved 
3) Added further improvement to OLS Loop mode when operating with WaveID 
4) Auto detecting if OPM is plugged in 

Digital fiber inspection scope improvements 

1. Auto detecting if FiberScope plugged in 
2. Allows access to FiberScope application to view saved results when FiberScope is not connected  
3. Added the Fiberscope shortcut icon to right side menu 
4. Added the big image/small image profile selection for new short round stem 
5. User can now decide in Setup what to do when Capture button is pressed (Disabled, Save on Tap, Save on Autofreeze) 
6. Added the Export USB command in the Scope Results tab 

Known Issues 

1. Real-time mode defaults to Manual mode test settings even when Auto mode or VScout selected 
2. For span > 80-90 km, 1310nm place EOF label by extrapolating slope to noise floor 
3. When splice gainer value exceeds splice loss P/F threshold, event table shows this as a failure 
4. Can’t view FiberScope image files in Utilities>File>Saved.  Must view and copy files using Scope APP Export USB. 
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Software version: 01.00.0025 October 24, 2017 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.1.7 
CPLD version: 8 

OTDR features and improvements: 

1. General enhancements 

2. Added ability to remove USB stick when operating in OTDR mode 

3. Added Russian, Spanish and Portuguese language 

4. Improved Kazakh and Turkish language 

5. Updated FX150 user manual 

6. Added ability to enable Software options in the field using Utilities>Settings>Software Option KEY CODE 

7. Setup Screen parameter now matches distance units  

8. File operation and related enhancements 

9. Improved OPM file detection 

10. Measurement and Analysis Improvements 

11. Added ability for user to optimize test for:  best deadzone, best dynamic range or Auto 

12. Improved Short span end of fiber analysis detection 

13. Improved end of fiber detection in noisy trace 

14. Changed attenuation to read dB/km regardless of distance unit settings  

15. Added Latency calculation in Event View and LinkMap view 

16. Added ability to set span by length as well as marker  

17. V-Scout changes and improvements 
a) Out-of-span events are now included in LinkMap  
b) General improvement of LinkMap Total Loss Calculation and now match Event Table results 

OPM/OLS/OLTS features and improvements: 

1. Improved OLS LOOP mode which will automatically cycle through all available lasers on OLS test port. 
2. New OPM server button available for remote control.  

Digital fiber inspection scope improvements: 

1. Added support for new VS500 FiberScope with software support enabled inside probe  
2. Changed FiberScope Save to match OTDR and OPM filenaming format/structure 
3. Added ability to interface FiberScope with Cloud 
4. Expanded fiber non-centering allowance required for AutoFreeze & Pass/Fail operation  

Known Issues to addressed in future release: 

1. Real-time mode defaults to Manual mode test settings even when Auto or VScout selected 
2. When gain splice value exceeds splice loss P/F threshold, event table shows as failure erroneously 
3. V-Scout View column labels remain in English when Spanish is selected. 

Software version: 01.00.0022 July 24, 2017 

Release Scope:  
Formal Release. General availability 
Boot Rom version: 1.1.5 
CPLD version: 8 
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OTDR features and improvements: 

1. General enhancements 
a) Improved backlight auto brightness control and LCD touchscreen calibration 
b) Improved Italian and Chinese character set Language support 
c) Added Spanish, Portuguese, Kazakh and Turkish language support 

2. File operation and related enhancements 

a) Utilities>File>Saved pdf icon is now disabled.  For pdf, users must use OTDR Settings Enable+Report 
b) Added ability to PULL data from Fiberizer Cloud into test set from Results Tab view 
c) Added ability to export all files directly to USB stick in VeEX tree or Flat format from Results Tab View 

3. Measurement and Analysis Improvements 

a) Improved LinkMap total length measurement and Total Loss measurement 
b) Improved cascaded PON Auto test functions and splitter event detection and end detection for lower dynanmic 

range OTDR models and increase measurement time to 60 seconds 
c) Improved Automode End of Fiber detection if end resides near noise floor 
d) Improved detection of splices located near the noise floor 
e) Improved test time for PON 
f) Added ability for users to exclude loss of internal G.657 fiber connector loss to test fiber and extrapolate scatter 

loss to 0 km for Total Span Loss value 
g) Allow user to add max. connector loss to Total Span Loss value when excluding OTDR connector loss (this is used 

when test fiber is not G.657 fiber type or external launch fiber does not match test fiber type.  
h) Improved PON auto analysis, splice detection between splitters and use additional trace capture if needed 

i. 2xN splitter support added for Manual PON 
ii. Added User defined Splitter loss threshold now in Test Setup Page 2 Analysis 
iii. PON distance range limited to 25km and physical max length restricted to 20km 
iv. Change PON short to PW = 25 nsec; no longer 3 nsec 

i) For post-measurement threshold changes, user can edit trace using Traces>Information area to select trace and 
edit test settings.  In Event tab>Modify initiates re-analyze to build new event table.  

j) Added 1650nm and improve Index of Refraction selection 
k) Improved Automode for fiber > 160km and PW>10000nsec 
l) Enable/Disable Front Panel Connection check in all test modes (Manual, Auto and Vscout) 
m) For SM fiber, set min dB/km = 0.17 
n) Improved 0km position for APC front panel connection 
o) Realtime (Live) mode trace stabilized, less fluctuation 
p) Added ability to select predefined Index of Refraction/Scatter Co-efficient or Custome User value 
q) Improved End of Fiber detection when last section has higher Scatter coefficient 
r) Improved Link map total length measurement and Total Loss measurement 
s) Added ability for automode to use different pulse for 1310nm than 1550nm for long fiber spans. 

4. V-Scout changes and improvements 

a) Improved APC connector loss/reflectance/detection on LinkMap 
b) Improved PON splitter type, loss calculation and linkmap association 
c) Manual PON splitter ratio drives linkmap icon 
d) Improved Span length measurement when last event is merged 
e) Improved LinkMap high splice loss measurement  
f) Generate linkmap option added 
g) Added ability to edit icons and rebuild Vscout report 
h) Added comments regarding span issues. 
i) Support up to 3 acquisitions/wavelength if needed in V-Scout 
j) Added 2xN splitter icons 

OPM/OLS/OLTS features and improvements: 

1. New Loop mode added 
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2. OLTS Wizard GUI added 

Digital fiber inspection scope improvements: 

1. Added support for VS900 Fiberscopes 

Known Issues to addressed in future release: 

1. Real-time mode defaults to Manual mode settings 
2. When distance units set to kilofeet or feet, settings are still in km 
3. When distance units set to kilofeet or feet, event table section attenuation not retaining dB/km units 
4. When gain splice value exceeds splice loss P/F threshold, event table shows as failure erroneously 
5. Export from OTDR APP requires user to select actual folder that contains .sor+pdf files. 
 

Software version: 01.00.0259 February 14, 2017 

Release Scope:  
Boot Rom version: 1.0.7 
CPLD version: 6 
Formal Release. General availability.  

OTDR features and improvements: 

1. General enhancements 
a) Added Chinese language support 
b) Improved Russian language translation  
c) Improved Bluetooth connectivity and performance 

2. File operation and related enhancements 
a) Added TraceID field content to .SOR and .PDF filename 
b) Uploading OTDR test results to Fiberizer Cloud implemented 

3. Measurement and analysis improvements 
a) Improved Automode PW selection for lower dynamic range OTDR models 
b) Improved cascaded PON Auto test functions and splitter event detection and end detection for lower dynamic 

range OTDR models and increase measurement time to 60 seconds 
c) Limited Max PON fiber distance range setting to 25 km 
d) Limited Max PON fiber span to 20 km 
e) Improved Automode for 100+ km fiberspans 
f) Improved End of Fiber detection on noisy traces 
g) Support up to 3 acquisitions/wavelength if needed in V-Scout 
h) Added 1650nm P/F thresholds and Refractive Index 

4. V-Scout changes and improvements  
a) Miscellaneous improvement to link map 

OPM/OLS/OLTS features and improvements: 

1. Improved Relative Power (dBm) refresh updates 
2. Save/Open VeEX*.oxlts file format implemented 
3. Results table for OPM measurement added  
4. Job/Cable/Fiber ID added for saving results 
5. Uploading of test results to Fiberizer Cloud implemented 
6. Open existing measurement file to add more measurements  

Digital fiber inspection scope improvements: 

1. Enabled Profile Activate button 
2. Added support for VS500 and new DI-1000 product ID 
3. Improved centering detection 
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Software version: 01.00.10 December 16, 2016 

Release Scope:  
Boot Rom version: 1.0.6 
CPLD version: 6 
Formal Release. Commercial Release and General Availability.  
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References  

Updating the Test Set Software 

To download the latest software version available, go to https://www.veexinc.com/support/software, enter the first four 
characters of the test set’s serial number (e.g., TAC0) and use the links to download the software packages and Release 
Notes to the PC. Unzip the file to obtain the Software Image file (i.e., fx150-veex-arm.tar.gz). The test set must always be 
connected to the AC/DC charger during the entire upgrade process. DO NOT turn it off at any time; the update process will 
take several minutes. To verify the software version number installed, turn the test set back on, open the Utilities section, 
select Settings, and open About. You may also use Web Remote Access to get the information. 

Using a FAT32 micro-B USB memory stick or FAT32 USB-A Memory Stick with an OTG adapter 

Make sure the test set can detect the memory stick, before starting this procedure. 

 Turn the test set’s power OFF. 

 Copy the Software Image file to the root of the memory stick. 

 Plug it into the test sets micro USB-B port or into the USB-A to micro-B USB OTG adapter. 

 Option A: For a clean install (reset all settings and clear internal storage), turn the test set ON, by pressing the 
SAVE+POWER buttons simultaneously, until a tone (beep) is heard and wait for the bootup process to finish. 

 Option B: To preserve some existing settings and data, turn the test set ON, by pressing the POWER+HOME buttons 
simultaneously, until a tone (beep) is heard and wait for the bootup process to finish. 

 The firmware update process starts. This will take several minutes. The test set will reboot itself at the end of the process. 

Updating the Test Set Software via Wi-Fi or LAN 

Make sure the test set is ON and connected to Wi-Fi, or to a LAN using the micro-B USB-RJ45 adapter cable.  

PCs, Mac, tablets, and smartphones can be used to perform this task if they provide access to the file system and allow you 
to select the install package file. 

 Open the Web Browser and enter the IP address of the test set into the browser’s address/search field (e.g., 10.0.20.1). 
The test set’s IP address is displayed at the bottom-left corner of the screen. 

 Once the test sets Web Remote Access page loads, select Upgrade from the menu on the left side of the screen. 

 Tap or click on the Select File button and point it to the Software Image file. 

 Tap or click on the Upload button to transfer the Software Image file to the test set. 

 Once the file transfer is done, tap or click on Upgrade and let the test set go through the process, uninterrupted. This 
will take a few minutes. The test set will reboot itself at the end. 
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